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GENERAL USER INTERFACE 

USER INTERACTION CONSISTENCY 

CTRL AND SHIFT BEHAVIORS 

 Multi-selection in the Design Explorer and Work Area using Ctrl and Shift has been uniformly 
implemented. Previously their use was treated differently in various tools or areas of the product. 
 

 Dialog boxes that use multiple inputs (for example, a Loft dialog that can take multiple profile sketch 
inputs) no longer require you to use CTRL or SHIFT to select multiple objects.  
 

 More commands can be applied to multiple objects in a single operation: 
 

o Anchor 
o Hide  
o Color Properties  
o Suppress 
o Show Reference Geometry 
o Move View to Sheet  
o Align View 
o Show Hidden Lines on View 
o Show Tangent Edges on View 
o Reproject Design Dimensions on View 
o Insert Centers on View 
o Insert Cosmetic Threads on View 
o Insert External Thread Call Outs on View 
o Insert Hole Call Outs on View 
o Scale View 

RIGHT-CLICK BEHAVIOR 

When selecting multiple objects and then right-clicking, there is now a consistent experience to show options that 
are available to all selected items. Previously, in some cases a right-click would deselect all selected items. This is 
particularly noticeable in assemblies when trying to anchor, hide, suppress, etc. multiple parts simultaneously 
using mouse commands. 
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DRAGGING THE DOG BONE 

Dragging the Dog Bone in a Design, Drawing, or Assembly Explorer now behaves as expected. Previously, the action 
would cause unexpected behavior and would make dragging the Dog Bone unpredictable when dragging involved 
the Explorer pane scrolling up or down. 

APPLY BUTTON ADDED TO DIALOGS 

The following dialogs now contain an Apply button so you can make multiple instances of the features without 
having to re-invoke the tools: 
 

 Insert Point 

 Insert Axis 

 Insert Plane 

 Sketch -> Insert Point 

 Sketch -> Insert Axis 

 3D Fillet 

 3D Chamfer 

 Sheet Metal Closed Corner 

 Sheet Metal Corner Round 

 Sheet Metal Corner Chamfer 

 

MISSING DESIGN DIALOG RESIZABLE 

The Missing Design dialog is now expandable. This makes it easier to see what is going on in cases where the file 
paths are very long or the assembly is extremely nested. 

FOCUS BEHAVIOR IN DIALOGS 

In many dialogs that require multiple inputs, for example Revolve Boss (requires Sketch, Axis, and Angle), the focus 
in the dialog progresses automatically as you make inputs. You no longer need to move back and forth between 
your work area and the dialog to constantly switch the active input field. This reduces mouse travel and allows you 
to design more quickly. 
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IMPROVED CONSTRAINT AND FEATURE CONFLICT VISIBILITY 

 Failed features are now more visible with an improved failed feature icon and red text in the Design 
Explorer. 
 

 
 

 Constraint conflicts are now shown in the same manner as failed features, improving the visibility of 
constraint problems. 
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3D PDF EXPORT – METRIC UNITS 

When a workspace is set to use metric units, the Publish to PDF dialog automatically changes to metric sizing. 
 

 

UNIFIED MATERIAL SELECTION 

When selecting a material for a part on the Material pane of the File Properties dialog, the Material Property of the 
Part Data is automatically updated. The Material Property of the Part Data pane is what is used when projecting 
fields in 2D drawings or in BOMs. This means that you can select a material in one place instead of two. 

LICENSING DIALOGS CLEANED UP 

The dialogs for license updates and changes have been cleaned up. 
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OPEN/IMPORT DIALOGS CONSOLIDATED 

The Open and Import dialogs have been consolidated into a single Open dialog: 
 

 
 

SAVE AS & SAVE ALL AS DIALOGS CONSOLIDATED  

The following changes have been made to the Save As and Save All As dialogs: 
 

 The two dialogs have been consolidated. 

 You now have additional options to selectively create a new file or overwrite a previously saved file, which 
means you can selectively choose to leave certain files in their existing locations during a Save As 
operation. 
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GENERAL CHANGES 

ACIS VERSION 

The ACIS version has been upgraded to R23. 

ALIBRE STEP REPLACED WITH GEOMAGIC PACKAGE 

The Alibre STEP format has been replaced by the Geomagic Package. The package format acts in much the same 
way as the Alibre STEP format, but has improved data fidelity. You can Create and Restore a Package file from the 
Gem Menu: 
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This will create a single file that contains all the data for your design. Similar to the Alibre STEP, creating a package 
of an assembly or a 2D drawing will include all the constituent files, such as parts and assemblies. When restoring a 
package, you will select where to deposit the original design files: 
 

 
 

Subsequently, you will be asked if you want to open the file from which the package was originally created: 
 

 
 
 
 
 
 

STL EXPORT OPTIONS 

ON-DEMAND OPTIONS 

When exporting an STL, you will be prompted with a new dialog that allows you to select options specific to the 
design you are exporting. This makes it easy to change your settings between files rather than having to change 
the global options. You can also select which units you would prefer the STL to be output in, which is useful for 
some downstream applications that recognize STL units. 
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If you prefer to set the options one time and not get prompted on every STL export, open the System Options and 
uncheck Show STL options on Export from the STL pane: 
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BINARY FORMAT 

Geomagic Design now supports the binary STL format. A binary STL offers identical fidelity to a human-readable 
STL but with a significantly compressed file size. You will almost always want to choose binary STL as your export 
option because of the file-size advantage.  

CONFIGURATIONS 

LOCK & UNLOCK ALL 

A new option to lock or unlock all Configurations is available via the right-click menu. 

 

LOCK AND UNLOCK BEHAVIOR MORE INTUITIVE 

Previously when locking a configuration, all lockable settings for the target configuration were automatically 
locked, overriding the user-selected settings. This forced you to reconfigure your settings when switching between 
a locked and unlocked state. This behavior has been modified to retain the user-selected lockable settings during a 
lock and unlock action. 

SYMBOL LIBRARY 

The following symbols have been added to the Symbol Library: 
 

 

MEASUREMENT INFORMATION AVAILABLE IN THE STATUS BAR 

Basic measurement information is now available in real-time in the Status bar at the bottom right of the screen 
based on your active selection(s). This allows you to avoid invoking the measurement tool for every measurement. 
Click on 3D geometry to check its measurement. The following measurements are supported: 
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Fillets, Cylindrical Faces, Spherical Faces, Circular Edges: Radius 
Non-circular Edges: Length 
Non-cylindrical and Non-spherical Faces: Surface area 
2 Parallel Faces or Edges: Distance between the selected items as measured from the nearest points 
2 Cylindical Faces or Edges: Angle between Axes 
2 Planar Faces or Linear Edges at an Angle: Angle between faces  
 

 
 
 
 
 
 
 
 

 

SKETCHING 

TRACING PERFORMANCE 

When tracing images in a 2D workspace to generate a sketch to be used in a 3D model, the sketching performance 
is significantly improved and more responsive, especially when zoomed in. Previously, zooming in on an image 
slowed down the sketching experience roughly proportionally to the zoom level. 
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DIMENSIONING BETWEEN CONCENTRIC ARCS AND CIRCLES 

Dimensions can now be placed between concentric arcs and circles to define the difference in their radii. 
Previously, you had to use the equation editor to define the offset distance from one parameter to another. This 
method is significantly faster and more intuitive. 
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DISJOINT ENDS 

All Disjoint Ends are automatically healed when the active Sketch is exited. You are no longer prompted that sketch 
problems exist when only Disjoint Ends exist, as they are automatically healed. Disjoint Ends were typically caused 
during the following scenarios: 
 

 Mirroring or patterning a figure or figures that have nodes that would “land” on top of other figures 

 Copying a 2D profile that was imported into a 2D workspace, for example a DXF or DWG file, into a 3D 
workspace to create a feature 
 

Disjoint Ends almost always resulted in unnecessary re-entry into Sketch Mode to fix them via the Sketch > Analyze 
tool and are now handled by the software. 

PRESSING ESCAPE ACTIVATES SELECT TOOL 

Pressing Escape while in 2D Sketch Mode will make the Select tool active. If a sketch figure has been partially 
placed, the first Escape will cancel the figure and a subsequent Escape will invoke the Select tool. 

COPY WITH BASE POINT 

A new Copy command, Copy with Base Point, allows more precise control when using the Paste Stamper. The tool 
allows you to define the point that will be coincident with your mouse while you use the Paste Stamper, which can 
be especially helpful when utilizing inference lines while pasting. 
 

 
 
Tip: 

 Copy with Base Point and Paste Stamper are particularly useful tools. The default keyboard shortcuts for 
these commands are Shift+C and Ctrl+T. 

 

IMPORTING POINTS INTO A 2D SKETCH  

You can now import Points from a CSV file into a 2D Sketch. Previously, this was only possible for a 3D Sketch. You 
have several options on how the software will treat the imported points: 
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 Fitting a Spline by Reference Points through the points 

 Fitting a series of Lines through the points 

 Fitting no figures and only creating points 
 

 
Requirements for the CSV file: 
 

 The CSV file should contain no headers 

 The CSV file should be formatted in the following way: 
o The first column should contain the X values 
o The second column should contain associated Y values 

 
Tips:  
 

 The software will treat the points in the order they are presented in the CSV file. This is important when 
fitting figures through the points. 

 If you are fitting a Spline or Lines through the points and desire the profile to form a closed loop, repeat 
the first point definition at the end of the CSV file. 

SKETCH ANALYZE DETECTS SELF-INTERSECTING SPLINES 

The sketch analyze tool now detects self-intersecting splines. 

HORIZONTAL AND VERTICAL CONSTRAINTS 

Horizontal and Vertical constraints can now be applied to multiple figures simultaneously. 
 

PART MODELING 

EXTERNAL THREADS HAVE PREDEFINED THREAD DEFINITIONS 

The External Thread tool now offers drop-down menus of thread definitions. This information carries over into 2D 
drawings automatically when you select to include External Thread Callouts on a created view. You can optionally 
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filter the thread options to display only the threads that typically would make sense based on the size of your 
selection. Disabling the Filter Threads by Selected Geometry option allows you to select any available thread. 
Previously External Thread Callouts had to be entered manually in the External Thread dialog. 
 

 
 

DRIVEN DIMENSIONS 

Three significant changes have been made to dimensions that greatly enhance their potential:  
 

 You can now designate any 2D dimension to be Driven during dimension placement or after dimension 
placement by modifying the dimension. “Driven” refers to the fact that the particular dimension does not 
explicitly drive model geometry, but rather it reflects the current measurement. Most dimensions you 
place in Geomagic Design are Driving dimensions – placing Driving dimensions will explicitly define the 
size or orientation of sketch figures. 
 
Driven dimensions update in real-time as you move figures or further define objects in the sketch. One 
useful way to use this is to use the Driven dimension as a “probe” to determine the dimensions of certain 
critical aspects of the design while you define the design with explicit dimensions. 
 
Previously, Driven dimensions could only be created automatically when you attempted to dimension a 
figure that was totally defined, and as such its dimension was automatically inferred based on the other 
dimensions or constraints in the sketch. 
 

 
 

 You can now designate that a Driven dimension show up in the Equation Editor as a parameter. 
Previously Driven dimensions could not be parameterized.  Allowing the parameterization of Driven 
dimensions in the Equation Editor provides some interesting and useful workflow improvements, noted 
later. 
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  You can now use Driven Dimensions that are parameterized to drive other parameters: 
 

 
 

USING DIMENSIONS FROM ONE PART IN ANOTHER PART 

By utilizing the changes shown above, you can effectively use dimensions from one part in another part. To do so, 
use the following procedure: 
 

 In an assembly, create your first part. 

 Create a new part in the context of the assembly. 

 Enter 2D Sketch Mode and use Project to Sketch with Maintain Association checked on to project the 
desired geometry that you would like to reuse. 

 Dimension this geometry. These dimensions will be Driven dimensions by default. During the 
dimensioning process, choose the Parameter option. 

 In the Equation Editor, you will now have parameters for the projected figures which represent the 
parameters you used during the creation of the first part.  
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ALIBRE VAULT INTEGRATION 

AUTOMATIC CHECK-IN PROMPT 

When you close a workspace that is using a file that has been checked-out from the Vault, you are now prompted 
on whether you want to check the file in. Closing a workspace in which you have modified several constituent files 
(for example, in an assembly) will prompt you to Check In all constituent files. 
 

 
 

SHEET METAL 

LOFTED FLANGES & ASSEMBLY CONSTRAINTS 

Circle – Circle Lofted Flanges are now significantly more robust in assemblies and allow assembly constraints to be 
placed using the model geometry. Previously you had to use the Show Reference Geometry function on Circle-
Circle Lofted Flanges in order to use the default or user-created Axes and Planes to constrain these parts to other 
parts in the assembly. 

SHEET METAL PARAMETERS IN RIBBON 

Sheet metal parameters can now be accessed directly via the Ribbon: 
 

 
 

CONVERT TO SHEET METAL NAMING 

When using Convert to Sheet Metal, the new sheet metal part inherits the name of the part file it is created from. 
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CONVERT TO SHEET METAL – TRIM CORNER OPTION 

A new option in Convert to Sheet Metal allows you to automatically trim the bend areas where corners converge. 
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SKETCH BENDS 

This new tool allows you to create bend lines directly from a sketch. These bend lines are used to fold a tab or 
flange. This is particularly useful if you are trying to recreate a sheet metal part from an imported 2D drawing of a 
flat pattern. 

GENERAL SKETCH BENDS 

General Sketch Bends involve a sketch that crosses the entire length of the item you wish to bend. In this case, a 
Flange will be created with no Offsets: 
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CLOSED-FIGURE SKETCH BENDS 

When you create a sketch that contains a single closed loop, the Sketch Bend command will create a flange from 
the enclosed material as in the following example: 
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SKETCH BENDS WITH RIPS 

Sometimes you will want to create a Sketch Bend that also contains rips. This is done automatically when: 
 

 The sketch does not fully cross the face on which is it being drawn 
 

 
 

 The sketch you create does fully cross the face upon which it is drawn, but contains multiple figures 
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Tips: 
 

 Reference the Help to determine how the two options Reverse Tab and Reverse Flange will change the 
outcomes of the Sketch Bend operation. 

 Only contiguous figures are allowed; multiple sketch loops will cause the feature to fail. 

 Bends can only occur on linear figures. 
 

2D DRAWINGS – GENERAL 

DEFAULT DRAWING NAME 

The default drawing name is now taken from the top-level part or assembly on which it is based. Often this is the 
desired behavior and automates the naming of drawing files after their logical constituents. You may override this 
behavior if desired. 
 

 
 

SET LAYER BY PART OR SUBASSEMBLY 

You can now set the layer of parts, assemblies, or subassemblies in 2D drawings. Previously, you could only set the 
layer of the projected edges. This makes applying different layer styles to different parts in a drawing extremely 
fast. This is particularly useful when showing the progression of a sheet metal forming process and for highlighting 
important areas in a drawing. 
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DIMENSION STYLES USER INTERFACE 

The Dimension Styles interface has been migrated into the File Properties dialog, accessible from the Gem Menu > 
Drawing Properties in a 2D drawing workspace. 
 

 
 

GENERAL DIMENSION TOOL BEHAVIOR (2D DRAWINGS) 

When using the Dimension tool in a 2D drawing workspace, the Sketching interface is no longer automatically 
invoked. Instead, you can use the Dimension tool while maintaining the Drawing Management tab of the Ribbon 
Interface. This means that you can quickly switch between applying dimensions and other annotations without 
having to switch tabs or exit Sketch Mode. Only applies to the Ribbon interface. 

DIMENSION REPOSITION TOOL AVAILABLE IN SKETCH MODE (2D DRAWINGS) 

The Dimension Reposition tool is now available in regular 2D Sketch Mode when sketching on the sheet. Previously 
it was only available for dimensions that had been placed on projected figures. 

SPLINE & FONT USAGE 

Several improvements have been made regarding imported splines from a DWG or DXF and regarding using splines 
related to the Text Tool. The improvements make handling particularly difficult splines or unconventional font 
definitions more robust and less likely to fail during 3D modeling operations. 

CONSTRAINT INFERENCING WHILE SKETCHING IN 2D DRAWINGS  

While sketching in 2D drawings, all constraints are now inferred as if you were drawing in a 3D workspace. 
Previously, certain constraints, such as Concentric, were not inferred automatically. 
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SHOW PART IN EXPLORER 

The part associated with a projected edge can now be displayed in the Drawing Explorer by right clicking on the 
edge and selecting Show Part in Explorer: 
 

 

DRAGGING MULTIPLE VIEWS 

Multiple views can now be dragged simultaneously. Select the desired views while holding down Shift to multi-
select them, and then drag to the desired location. 

NEW DRAWING TEMPLATES 

 

 ANSI Templates have been updated to add appropriate margins. 

 ISO Templates have been redesigned to conform to standards. Official ISO templates and simplified ISO 
templates are now available. 
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2D DRAWINGS – VISUAL FIDELITY VIA ADAPTIVE FACETING 
The visual fidelity of curved items in drawings has been significantly improved. Now several options exist in 
addition to fundamental algorithmic changes: 
 

 Adaptive Faceting – automatic and always on: 
o Faceting has been significantly improved to consider the relative sizes of the 2D geometry during 

2D drawing creation. The result is significantly improved visual fidelity.  
 

 Adaptive Faceting slider option: 
 

o The Curve Smoothness value now allows you to select multiple settings for adaptive faceting. 
Setting higher values means the upper and lower bounds for curve smoothness will be set higher. 
Setting the value lower will lower both values. 
 

o It is important to note that not all drawings require the highest level of smoothing, especially if 
your drawing contains primarily linear figures. If you are suffering from performance problems, 
especially in very large or complex drawings, you may benefit from reducing the Curve 
Smoothness value. 

 
To access the adaptive faceting options, select the Gem Menu > File Properties > Display tab from a 2D Drawing 
workspace: 
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2D DRAWINGS – PRINTING AND PRINT PREVIEW 

PRINT PREVIEW FOR 2D DRAWINGS 

Print Preview has been completely redone. It now has the following benefits: 

 Significantly higher fidelity 

 Opens full screen 

 Interactive (easy zoom, pan, etc.) 
 

2D PDF GENERATION 

Publishing to PDF in a 2D Drawing will now automatically set the size of the PDF. 

PRINTING 

LINE WEIGHT AND SCALE 

Improvements have been made to properly print line weight and scale. 

PAGE SIZE SELECTION 

When printing your paper size is automatically set to match the size of your sheet when possible. 

MARGINS 

Margins in templates are now upheld when printing. 

PAGE DOES NOT FIT BEHAVIOR WHEN USING METRIC TEMPLATES 

The Page Does Not Fit error now shows appropriately. Previously, templates defined in metric units sometimes 
caused the unnecessary display of this message. 
 

2D DRAWINGS – DWG/DXF IMPORT/EXPORT 

AREAS OF FOCUS 

Significant improvements to DWG/DXF interoperability have been made regarding the accurate representation of 
various components of 2D documentation when importing or exporting. The following import and export-related 
areas are more robust: 
 

 Feature Control Frames 

 Word wrap 

 BOM text 

 Dimension lines with symmetric tolerances 

 Dimension arrows, arrow heads, and section lines being correctly represented  

 Various Text issues 

 Various issues related to fractions 

 Issues related to certain views coming in as solid when imported into Geomagic Design 

 Font size or changes being incorrectly represented in external programs 
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 Scaling of various font issues 

 Issues related to Corel outputs 

 Incorrect display of section view lines in some instances of imported DWG files 

 Various issues related to French operating systems 

 Issues related to imported hatches 

 Issues related to scaling templates 

 Layer support for tables when importing 

 Layer color support 
 
 
 

2D DRAWINGS – VIEWS 

NEW VIEW TYPES 

SHADED VIEWS 

Shaded Views allow you to mimic the 3D visualization of components in a 2D Drawing.  
 
 
 
 

 
 
 
 

 
Shaded Views can significantly increase the understanding of engineering drawings and downstream applications 
such as marketing materials. They can also help to create buy-in from those less-familiar with traditional 2D 
documentation concepts as they are more readily understood by non-technical people. Shaded Views are available 
for all view types. For example, you can use Shaded Views to help illustrate a section drawing: 
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Create a Shaded View in the following ways: 
 

 During initial view creation in the Standard View Creation dialog, select Shaded View from the View Type 
area. 
 

 
 

 Convert any existing view into a Shaded View via the popup menu by: 
 

o Left-clicking on the view to invoke the popup. Hover over the View Display area and select 
Shaded. 
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o Or right-clicking on any view and selecting View Type > Shaded: 
 

 
 

Tips: 
 

 Shaded Views inherit their color from part and assembly colors. 

 To change the color of a shaded view, edit the color of the part or assembly. Save the part or assembly 
and reproject the drawing. 
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 Shaded Views have the same limitations as Fast Views. Check the Help for Fast View and Shaded View 
limitations to determine if you need to do any up-front planning based on your desired outcome. 

SECTION VIEW – ALIGNED 

A new section view type, Aligned Section View, is now available from the Section View dropdown. It is used when 
the desired section lines are at an angle. Regular section views will cause certain features to appear foreshortened 
when the section definition contains figures at an angle. The Aligned Section view allows you to create a proper 
section without foreshortening. 
 

 
 
To access the Aligned Section view, select the Sheets and Views tab in a 2D drawing and then select Aligned 
Section View from the section dropdown: 
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SECTION VIEW – BROKEN OUT 

Broken Out Section Views act similarly to an Extrude Cut and are useful for showing the occluded interiors of 
objects. 
 

  
 
To access the Broken Out Section View, select the Sheets and Views tab in a 2D drawing and then select Broken 
Out Section from the section dropdown: 
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Tip: You can define the depth of the Broken Out Section by selecting a projected edge that represents the depth 
you desire. You can select this edge from any view. Often, you will select this edge from a view that is rotated 90 
degrees. 
 

 
 

SECTION VIEW – REMOVED 

Removed Section Views will create a section view that only displays geometry that lies directly on the cutting 
plane. This is useful for showing localized detail when a regular section view would create unnecessary geometry 
that complicates the desired detailing. 
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To access the Removed Section view, select the Sheets and Views tab in a 2D drawing and then select Removed 
Section View from the section dropdown: 
 

 
 

SECTION VIEW – REVOLVED 

Revolved Section Views are not an explicit command but can be accomplished by combining a Broken Out Section 
view and a Removed Section view. 
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To create a Revolved Section view, follow these steps: 
 

1. Create a new layer type that has the Visible checkbox unchecked. This will create a layer that allows you 
to hide things from the drawing: 

 
 

 
 

2. Project a view 
 

 
 

3. Create a Removed Section view 
 

 
 

4. Set the Section Line and Section Label layers to invisible by right clicking on them, selecting Set Layer, and 
selecting the invisible layer you created in step 1. 
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5. Optional: Create a Broken Out Section view that overlaps the Removed Section view with the Through All 
option and Hide Boundary options selected 
 

 
 

 
6. Move the Removed Section view you created in step 3 into the Broken Out section view you optionally 

created in step 5. 
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VIEW CREATION WORKFLOW 

A new workflow possibility now exists when creating view types that rely on your defined geometry, such as a 
section view relying on a section line. Previously, you had to Activate Sketch on a view, create the geometry, and 
then invoke a view tool and select the geometry you made. Now you can select which type of view you want to 
make first, select the target view, and automatically start drawing the geometry. 
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ADDITIONS TO BROKEN VIEWS 

Multiple Breaks can be applied to a single view. Overlapping breaks are supported (vertical break + horizontal 
break). Break line extents are now sized to the model rather than the view bounding box.  
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ASSOCIATIVE VIEW LABELS 

Detail and Section view labels are now associated between the view and the annotation. Changing the name for 
one will automatically change the name for the other. 
 

ADDING SCALE LABELS TO VIEWS 

You can add a Scale value to any view that will update as the view scale changes: 
 

 
 
 

To add a scale label, right click on the view and select Scale. Check the Show View Scale Note box: 
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You can change the way Scale information is presented the Drawing Properties dialog: 
 

 
 
 

2D DRAWINGS – ANNOTATIONS 

GENERAL 

WEIGHTS 

Annotations now support line weights. 

LAYER SUPPORT FOR TEMPLATES AND CUSTOM SYMBOLS 

Templates and Custom Symbols now fully support layers and line weights. 
 
Templates and custom symbols retain their original layers when inserted into a new drawing. Previously, all 
templates and custom symbols would be set to the continuous layer, and changing the layer attributes of an 
individual component of a template or custom symbol required the Explode command. Now, you can create 
templates and custom symbols with any variety of existing or custom layers and reuse them exactly as they are. 

LAYER SUPPORT FOR TABLES 

Tables can now be set to an existing or custom layer by right clicking on the table and selecting the Set Layer 
command. 
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DATUM, DATUM TARGET, AND FEATURE CONTROL FRAME ATTACHMENTS 

Now you can attach Datums, Datum Targets, and Feature Control Frames to Dimension Leaders and Feature 
Control Frames. The attachments are associative and will move when the original item is moved. 
 

 
 

When placing a Datum, Datum Target, or FCF hover over a dimension or FCF until it highlights. Clicking in this 
position will attach the leader. 
 
 
 
 

DIMENSIONS 

FORESHORTENED DIMENSIONS 

It is now possible to foreshorten a linear or circular dimension. Configuration options are available from Dimension 
Styles. You can change the position of the jag for linear dimensions by hovering over it and dragging the node. You 
can change the position of the end-point (and subsequently the jag) of a radial dimension by hovering over it and 
dragging it. 
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To foreshorten a dimension or dimensions, use the right-click menu or the in-place editing menus: 
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To change the appearance of foreshortened dimensions, access the Foreshortened Dimensions pane of the 
Drawing Properties dialog: 
 

 

DIMENSION GAPS 

You can set dimensions to be gapped such that when they cross other dimensions a gap will automatically be 
placed at the intersection point. 
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To designate a dimension as a gapped dimension, use the right-click menu or the in-place editing menu: 
 

 
 
There are two options for gapped dimensions available from the Drawing Properties dialog: Width and Gap Only 
at Arrowheads: 
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ORDINATE DIMENSIONS 

Ordinate dimensions are now easier to move. They automatically align and when you move one, the rest move in 
unison. 
 

 
 
Chained Ordinate Dimensions are now supported: 
 

 
 

To set ordinate dimensions to be chained, select the option from the Drawing Properties dialog: 
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DIMENSIONING CLIPPED FIGURES 

Previously when figures were clipped in certain view types, for example partial and detail views, they could not be 
dimensioned and you would be required to select their end nodes instead. Now all figures can be dimensioned 
regardless of their clipped status. 

 

THREADS 

ABILITY TO USE COSMETIC THREADS FOR DIMENSIONING 

You can now select the cosmetic thread lines in 2D drawings for the placement of dimensions: 
 

 

VISIBLE AND OCCLUDED HOLE THREAD REPRESENTATION 

You can set the layer of the thread representation for internal cosmetic threads based on whether the threads are 
occluded or not (for example, in a section view): 
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To set the layer and angle options for these threads, view the Threads pane on the File Properties dialog: 

 

CENTERLINES 

MANUAL INSERTION FOR LINEAR AND CIRCULAR GEOMETRY 

The Insert Center tool is available from the Drawing Management tab of the Ribbon: 
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This allows you to manually insert centerlines between two linear or two circular edges regardless of the source 
geometry.  
 

 
 

OVERLAPPING CENTERLINES 

Centerlines that overlap linearly are now consolidated into a single centerline. 

DRAGGABLE CENTERLINES 

Centerlines now have draggable nodes. To resize the centerline, select a node and drag it. 
 

 
 

INTELLIGENT DIMENSIONING TO CENTERLINES OF CIRCULAR OBJECTS 

When dimensioning to the centerline of a circular feature, several options exist on how to treat the dimension: 
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To access the options, select the Circular Dimensions pane from the Drawing Properties dialog: 
 

 
 

ADDITIONAL SPACING OPTIONS 

A new Long Dash option is available on the Drawing Properties > Annotations pane: 
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DIMENSIONING CENTER MARKS 

Now dimensions can be placed between the central nodes of center marks. This is useful in cases where the rest of 
the center mark is not oriented in a horizontal/vertical position, for example when they are rotated in a PCD 
layout. 
 

DATUMS 

MULTIPLE DATUMS WITH SAME LABEL 

Datums can now be created that have the same label as a previously created Datum on a single sheet or across 
multiple sheets. 

DATUM SNAPPING 

Datum triangles now snap to selected geometry at the correct angle. Smart Anchoring applies to datums so the 
leader behavior is correct. Snapping such that the leader is directly horizontal or vertical to the datum is automatic. 
 

 
 
 
 

DATUM TARGETS 

MOVABLE OPTION 

A new option to create a movable datum target is available: 
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NEW ARROWHEAD TYPES 

The Cross and X are now available: 
 

 

FEATURE CONTROL FRAMES 

ALL OVER LEADER SYMBOL 

The All Over symbol is now supported for feature control frame leader lines: 
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This is accessible from the Feature Control Frame dialog: 
 

 

CUSTOM TEXT IN FEATURE CONTROL FRAMES 

Custom text can now be entered in the Feature Control Frame dialog: 
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HOLE PATTERNS 

CALLOUTS 

When using a Pattern or Mirror operation on a 3D Hole feature, the 2D callout now reflects the total number of 
holes properly. 

PCD 

If you use a Circular Pattern on a 3D Hole feature, you can now project Centers in a 2D drawing with PCD lines. In 
this case, the centers of the holes are also rotated automatically. 

 

 
 

PCD options are located in the Document Properties on the Detailing pane: 
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You can disable PCD lines by unchecking the Circular Hole Pattern option. You can also adjust the layer and PCD 
type from this dialog. 

LINEAR HOLE PATTERN ANNOTATIONS 

 
When creating an 2D drawing of a part that has a 3D Hole feature that uses a linear pattern, the pattern lines will 
be created when projecting Centers. 
 

 
 

Linear hole pattern options are available from the Drawing Properties > Detailing pane: 
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CHAMFER CALLOUTS 

A new chamfer dimension tool is available from the Dimension dropdown in 2D drawings: 
 

 
 

To use the tool, select the chamfered edge, then select the first and second reference edges as indicated by the 
status bar at the bottom of the screen. The chamfer will be ready to place. Several style options exist for the 
chamfer dimension: 
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Options can be selected from the Drawing Properties dialog on the Text pane: 
 

 
 

POINTS 

When in 2D Sketch Mode inside a 2D drawing, using the Point tool will create points that are visible in prints and 
exports. 

BOM CALLOUTS 

Creating BOM callouts with multiple leaders is now easier. 
 

 
 
To create multiple leaders, select the initial part and place the callout. Continue to click on additional parts to add 
additional leaders.  
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BILL OF MATERIALS 

BOM PROPERTIES 

 Surface Area, Volume, and Density are now available to be inserted into a BOM. The data is pulled from 
the model files. 
 

 
 

 BOM Properties are now organized in a clean, easy-to-read manner with properties separated by 
functionality: 

o Standard text properties 
o Design driven properties 
o Custom vault properties 
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BOM TEXT – AUTOWRAP AND MULTI-LINE 

Text wrapping is now supported. Multiline text is also supported. To create a multi-line entry, press Shift+Enter to 
begin a new line. 
 

 
 

AUTOFIT COMMAND 

Autofit now applies fitting logic to both column width and row height. Previously it only applied this logic to 
column width. Autofit can now be applied to the entire BOM in a single operation. 
 

API ENHANCEMENTS 
 
The following enhancements were made to the API: 
 

 Modify Sketch Text 

 Suppress multiple features 

 Disable auto-regenerate 

 Optimized applying assembly occurrence transformations with constraints 

 Create assembly constraints 

 New property for Session TimeStamp/VersionReference 

 Set view transform 

 Selecting individual sketch figures
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